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1 Introduction 

The Easy Compliance Lite Software is compatible with Apex’s CPAP System which is intended for 
the treatment of patients with Obstructive Sleep Apnea (OSA). 
 
The Easy Compliance Lite Software is used with Windows® based PCs and allows you to download 
usage data collected by the Apex’s CPAP device after treatment. The memory capacity in the 
Apex’s CPAP system can hold up to 730 sessions of summary data.  
 
In order to meet some FDA regulations, some features (mark with *) have been disabled in this 
version 

   
To ensure proper use of the software, please read all instructions prior to downloading data from the 
Apex’s CPAP. 

2 Installing and Starting Software  

� Preparations 

1. Make sure your PC is running on Windows® based system. It will not run on Mac systems. 
2. There are two steps to the software installation:  

i. Download the Easy Compliance software from website. 
ii. Install the USB drivers for the Apex’s CPAP. 

 
� System requirements 

Your computer must meet the following requirements:  
y Available Windows® supported USB port (USB 2.0) 
y Pentium-class processor; Pentium III 800-megaherz (MHz) or higher is recommended.  
y Microsoft Windows® XP SP2, Windows® Vista SP1, or Windows® 7 (32 bit). 
y 128 MB RAM. 
y CD-ROM drive compatible with multimedia desktop computer specifications. 

* 

* 
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y 1024 x 768 or higher resolution VGA monitor. 
y Minimum 100MB hard disk space for software and data.  
y Internet Explorer 7 or greater 

 

� Steps to Install Easy Compliance software 

1. Close all applications before installation. 

2. Find the installation program and double-click it. 

¾ Install USB-to-Serial: PL2303 Driver 

Note: Once this step is executed, PC will display the PL-2303 USB-to-Serial InstallShield 
WiZARD. It will guide you to complete the installation of the PL-2303 driver. If this driver 
has already been installed in your PC, just press “Cancel” button on the InstallShield 
WiZARD to skip this step.  

¾ Install PDF creation: CutePDF Writer 

¾ Install Easy Compliance Software 

Note: Once this step is executed, PC will display the Setup WiZARD. Following the 
instructions will guide you to complete the installation of the Easy Compliance Software. 
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In the “Destination folder” box, you can type in a directory path or press the “Browse” button 
to establish a folder and path on your hard disc that will contain the software. The default path is 
“C:\Program Files\Apex Medical\Easy Compliance 3.4 Lite\”. Press the “Next” button to complete 
the installation. Once the installation process is complete, click “Close” button to exit the 
program. 

 
� Install Software 

The software icon  will appear in the folder where you installed the software and also on 

the desktop. 
 

 
� Installing the USB drivers for Apex’s CPAP  

The USB driver should be installed automatically after the setup program is completed. For 
the first time to connect the device to PC with the USB cable, the message box below may appear. 
Found New Hardware WiZARD starts when Windows finish searching for the new hardware. 
Windows will ask you if it can connect to Windows Update to search for software. Select "Yes, this 
time only" then click "Next". 

 
 
When the window below appears, select "Install the software automatically 

{Recommended}" then click "Next". 
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The Found New Hardware WiZARD will start to search the hardware and show window 
below. 

 
 

During the search process, there may appear the warning message window below, click 
"Continue Anyway" to continue installation. The driver installation starts.  

  
 

Click "Finish" to complete the installation. Now you can download the data via USB Cable. 

 

Note: Some systems may need to restart the computer to complete the installation of the 
driver. 
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� Starting the software 

To use the software, double-click on the software icon . A new file will be displayed, and all 
software functions can be accessed. 
 

3 Using the Software 

3.1 New  
If you would like to create a file for a new patient, click the “New” Toolbar button or click 

“File” on the Menu Bar and then select the "New" item from the drop-down menu. Note that 
when you first start the software, the screen will already have a blank patient profile available (no 
need to press the “New” button). 

         
 File - > New 

Note: Before downloading new user data, it is necessary to have a patient file open first 
(create a new file, open an existing file or have a blank profile on the screen). 
Otherwise, the download function will fail.  

 
New File 
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When you open a new file, the main window with empty patient record will pop up. The 
functions of the various parts of the main window are described below: 
Patient Record 
There are seven tabs in patient record to present the data of patient profile, clinical details, 
patient notes, total usage time, compliance usage time, detail and long term report.  
 
Menus 
From the menus user can perform several functions to load/save file, edit patient record, 
download data from CPAP device, and see help file.  
 
Toolbar 
Users also can quickly perform the functions of menu by clicking 11 icons. 
 

 
Icon meaning 

 
 
3.2 Close 

If you would like to close the current patient file, click “File” on the Menu Bar and select the 
"Close" item. 

       
   File - > Close 

 
Once you execute this function, the current window will be closed and you will be asked to 

confirm whether you would like to save the current data or not. It is recommended that you save 
data before closing the patient file. 
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  Confirmation during the Close function 

 
After closing the patient file, the main window will be displayed.   

 

      Main Window 
 

 

3.3 Save 
If you would like to save the current data to the hard disk, click “File” from the Menu Bar and 

then select the "Save" item. You can also press the “Save” Toolbar button. 

       
       File - > Save 
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3.4 Save As 
Click “File” from the Menu Bar and then click “Save As” to the save data to another file. 

 
File - > Save As 

 
To save the current data to a different filename, type a new name into the “File name” box 

and click the “Save” button. 

 
“Save As” window 

 

 

3.5 Save Reports as PDF 
If you would like to save usage data reports as an electronic file, click on “File” from the 

Menu Bar and then “Save Reports as PDF”. All the usage data during the selected period will be 
converted into a PDF file. 

       
File - > Save Reports as PDF 
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3.6 Open 
If you would like to open an existing file, click “File” from the Menu Bar and then select the 

“Open” item. You can also press the “Open” Toolbar button. 

 
File - > Open 

 
1. When you select the “Open” item, the Open dialog box will appear. 
2. Search for your file (with .paf extension) in the dialogue box and select it by double clicking 

on it. 
3. By default, the Main Window will display the Patient Profile screen for the selected patient 

data. 
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3.7 Print 
If you would like to print the current window, click on “File” from the Menu Bar and then 

“Print”. You can also press the “Print” Toolbar button. 

 
File - > Print 

 
When you select the “Print” function, a dialog box appears allowing you to select the reports 

to be printed. You can choose to preview the content before printing or to convert the report to a 
PDF file. 

 
Report Type  
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       Summary Report 
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        Compliance Time Report, with limited 90 days of data 
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         Long Term Trend Report, with limited 90 days of data shown in the pressure graph 
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3.8 Print Setup 
If you would like to adjust the printing options, go to “File” (Menu Bar) -> “Print Setup”. You 

can adjust paper size, printer, landscape etc. 

 
 File - > Print Setup 

 
 
3.9 Exit 

If you would like to exit the Easy Compliance software, go to “File” (on Menu Bar) -> Exit. 

 
File - > Exit 

 
When you exit the software, you will be asked to confirm whether you would like to save the 

current data or not. It is recommended you save all data before exiting. 
 

 
Confirmation window while exiting the software 
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3.10 Edit Patient Profile 
If you would like to edit the patient profile data, click on “Edit” from the Toolbar buttons and 

then select the “Patient Profile” tab towards the top of the “Patient Information” window. A 
patient profile edit window will then display. Simply fill in or update the appropriate information 
and click the “OK” button. 

 

Edit - > Patient Profile 

Edit Patient Profile 
 
 
3.11 Edit Clinical Details 

If you would like to edit the clinical data for the patient, click on “Edit” from the Toolbar 
buttons and then select the “Clinical Data” tab towards the top of the window. Simply fill in or 
update the appropriate information and click the “OK” button. 

 

Edit -> Clinical Details 

 
Edit Clinical Details 
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3.12 Edit Patient Notes 
You can also add or edit the Patients Notes. When the Edit Patient Notes screen appears, click 

on any of the available 20 lines that you want to enter data for. The maximum number of Patient 
Notes is 20. 

 
Edit Patient Notes 

 

 

3.13 Edit Phone-in Data 
If you would like to edit the phone-in data, click on “Edit” from the Toolbar buttons and then 

select the “Phone-in Data” tab towards the top of the window. A phone-in data edit window will then 
display. Simply fill in or update the appropriate information and click the “Print” button. 

 

 
Edit -> Phone-in Data 

 

       

Edit Phone-in Data 
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Summary Report of Phone-in Data 
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3.14 Using a miniSD or SD Card 
The patient can use the miniSD or SD card to backup the most recent compliance data in the 

Apex’s CPAP system (for some models). Once the data is backed up, the patient will send the 
miniSD or SD card to you and the compliance data can be retrieved and analyzed using the Easy 
Compliance software. 

Insert the miniSD or SD card to the card reader connected to your PC. Click the “Card” icon to 
open the files saved in the miniSD or SD card. The files of type is “CPAP SDCard Files (*.cpe) or 
APAP SDCard Files (*.ape).  
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3.15 Download via USB cable 
This section describes how to download data from the Apex’s CPAP to your PC.  
To download data, there are three steps to follow –  

Step1. Connect Apex’s CPAP device to your computer with USB cable. 
Step2. Start the software and establish an internal connection (between the CPAP 

system and PC). 
Step3. Download data. 

Each step is described in detail below. 
 

Step1: Connect Apex’s CPAP device to your computer with USB cable. 

1-1. Plug the power cord into the power socket of the Apex’s CPAP device. Plug the other 
end of the cord into a wall outlet. Keep the CPAP system in Standby mode (no airflow). 
Download will fail if the device is providing airflow. 

1-2. Connect the Apex’s CPAP device to your computer using the USB cable supplied in 
package. The Mini-USB end (the smaller end) is for the CPAP system and the standard 
USB end (the larger end) is for the computer. 

1-3. Start the software on the PC by double-clicking on the icon  in the software 
directory. 

 

Step2: Start the software and establish an internal connection (between CPAP system and 
PC). 

Aside from the physical cable connections, it is necessary to establish another internal 
connection between the two devices, which is done through the PC’s Serial Ports (not to be 
mistaken for the physical Serial connectors). 
 
In most cases, you can have the software automatically establish these connections as 
follows: 
2-1. Click on the "Download" item in the Menu Bar and select the “COM port Auto 

Connect” item. 

2-2. The Software will automatically detect an appropriate connection for you. 

2-3. If the connection was established successfully, the message “Auto Connect Successful” 
will appear. Otherwise, the message “Auto Connect Fail” will appear. 

  
Download / COM Port Auto Connect 
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Auto Connect Successfully 

 

 
Auto Connect Failed 

 
-- PC fails to connect automatically –  
If the internal connection to the CPAP system fails, check the following: 
¾ Check if the power cord is securely attached to the Apex’s CPAP device, and the CPAP 

device is in standby mode 
¾ Check if the connecting cable is securely attached to the CPAP system and the computer. 
¾ Check the USB driver on the PC. Go to the Device Manager in your system to determine 

the appropriate driver installation steps. Open the Device Manager (located in "Control 
Panel\System" then select the "Hardware" tab and click "Device Manger…"), and select 
"View > Devices by Type" to make sure the device you install is correctly displayed. The 
device appears as an additional COM port with the label "USB Serial Port". If you don’t 
find an additional "USB Serial Port", try to reinstall the USB driver.  

 
Manually set Connect setting 
You can also manually set the connection setting but you must know the correct COM port 
number which Apex’s CPAP device uses. Check Device Manager in your system to find the 
correct COM port number. Select "View > Devices by Type," and under “Ports (COM & LPT),” 
look for a USB Device with “Prolific USB Serial Port (COMn).” Note that n is the number of the 
COM port assigned to the Apex’s CPAP device. 
  
2-1. Go into “Control Panel”>System and click the Device Manager button on the Hardware 

tab 

2-2. Select the menu “COM & LPT,” and find the COM port of “Prolific USB Serial Port 
(COMn)”. Right mouse click (or double click) for the “Properties” 

2-3. Select the Port Settings Tab. Click the Advanced button. 

2-4. Manually set the COM Port number. 

2-5. Go back to the menu bar of Easy Compliance and select correct COM port, and click 
“OK” button to confirm. 
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Click “Device Manager” 
 

 
Select “COM & LPT” and find “Prolific USB Serial Port”. Right mouse click (or double click) for the 
“Properties”. 
 

 
Select the Port Settings Tab. Click the Advanced button 
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Manually set the COM Port number  

 

 

Set COM port  

 

 

Step3: Start to Download 
3-1. To download the patient data from Apex’s CPAP device, click on "Download" from the 

Menu Bar and select the “Extract Data” function; the user’s therapy data will be 
copied to your computer’s memory (you can also click the “Download” Toolbar 
button). 

  
Note that after a download, the data on the Apex’s CPAP system will not be removed. Data in 
Apex’s CPAP system can only be erased through the control panel on the device. 
 
While downloading data, a progress indicator displays the percentage of data retrieved. 

     
    Download progress indicator 

     
    Download complete indicator 
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Once the data retrieval process has been completed, click “OK” and the Patient Profile screen 
will appear with the new information. 
 
 Software fails to download the data 
If the connection to the CPAP Device fails, you will be informed by an error message. 
Please check the following: 
¾ Check if the Apex’s CPAP device is powered on and in standby mode. 
¾ Check if the USB cable is secured at both ends. 
¾ Check if the connection between CPAP device and the computer is established by 

following Step 2 described above. 
 
To stop the download, simply press the Close button in the top right corner of the progress 
window. 
 
Important: Every time you download data to an existing patient file, all existing usage data for 
that patient will be erased. So, if it is important to retain existing data, remember to save the 
existing data to another file before downloading new data. The other option is to ALWAYS 
save the data to a new file after downloading.  
 

 
 
 
3.16 Help 

To obtain help for the software, click on the "Help" Tool Bar button. 
The Help documentation will appear in PDF format.  
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3.17 Patient Profile Tab & Clinical Details Tab 
General patient information can be viewed from two of the Information Tabs at the bottom of 

the main menu. This includes the “Patient Profile” and “Clinical Details” tab. Both tabs have an 
“Edit” Button in the lower right corner that you can press to access an “Edit” screen where you 
can modify/add information. 

 
Patient Profile View 

 
Clinical Details View 
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3.18 Patient Notes Tab 
The Patients Notes tab is a simple way to attach your own notes to the current patient file. To 

view and edit the patient notes, go to “Edit” (Menu Bar) -> "Patient Notes". When the “Patient 
Notes” window appears, you can click on any of the line items where you can add or edit your 
notes. The maximum number of notes is 20. 

 
Patient Notes 

 
 
3.19 Total Time Tab 

Total Time Tab displays a general overview of the device operating records for each day. The 
Total Time data has two sections. The left panel is the cumulated operating time for the device 
which is defined as the time airflow is flowing through the tube (whether or not the patient has 
donned the mask). The right panel shows the times during the day that the device was operating. 

 
Total Time Tab 
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View of Usage Profile Range (right panel) 

 
The Usage Profile Range (right panel) displays the time of day during which the device is 

running. A 24-hour period is shown as a horizontal bar, and starts at 12pm (noon) in order to 
capture one night on a continuous single line (since the devices is typically used at night). 

 
View of the cumulated daily device operating time 

 

 

3.20 Compliance Tab 
Compliance Tab displays an overview of the compliance records for each day. The Compliance 

tab is composed of two sections; the left panel is the cumulated daily compliance time recorded 
for each day; the right panel is the times during the day that the patient is receiving treatment.  

Compliance time is the time that the device is delivering airflow AND the patient is wearing 
the mask. 

 
Compliance Tab 
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View of compliance usage profile range 

 
The Compliance Usage Profile Range displays the times during the day where the patient is 

receiving treatment. A 24-hour period is shown as a horizontal bar and begins at 12pm in order to 
capture one night on a continuous single line. 
 

Note: In order to leave the patient enough time to settle into a relaxed state, the first 15 
minutes of each session is not recorded by the Apex’s CPAP device. 

Note: The compliance time and pressure data will be captured every 15-minute in the Apex’s 
CPAP system and user may turn off the device by pressing “START/STANDBY” button on 
the device. If a usage session is ended up by low pressure auto-off function instead of 
normally turning off manually, the compliance record shorter than 15-minute session 
will NOT be shown on the compliance view even though it is stored in the device 
memory. Therefore, there might be a few minutes difference in the meter record 
between software and the device LCD. 

 
There might be a slight discrepancy between the information on the Compliance tab and the 

data on the Apex’s CPAP device. If, at the end of a usage session, there was a drop in pressure in 
the mask (mask slips off), the last few minutes of a 15-minute session may NOT show on the 
Compliance tab (though it is recorded on the CPAP device). 

 
View of cumulated daily compliance time 

 
 
 
 
 



 28 

3.21 Long Term Data 
The Long Term data shows various statistical information regarding patient data. This tab is 

separated to two sections; the left panel is the daily pressure graph and right panel is the analysis 
data. The analysis data is composed of three pages which are Pressure, Compliance and Events. 

 
Time Edit 
To change the parameters for the Long Term data, you can click “Time Edit” button at the 

top-right of Long Term tab. And then an “Analysis Time Edit” window will display. Here, you can 
configure the select period and minimal compliance. 

¾ Selected period: The time period will be covered in the long term data. 
¾ Minimal Compliance: This is used to calculate the percentage of days that the user 

reached the “Minimum” hours of treatment 
 

 
Time Edit. 

 
Edit Analysis settings 

 

Pressure 
This page provides the information about average pressure & leakage. 
¾ Used Pressure 
y Average Pressure: The average pressure over the time period.  
y Average 90th Percentile Pressure: The pressure that user is stayed equal or lower of it for 

90% of the time. 
y Average Leak: The average leak for the time period. 
y Lowest Leak: The average lowest leak for the time period. 
y Highest Leak: The average highest leak for the time period. 
y Average Large Leak Time: The average time of large leak for any one day.  
¾ Pressure Graph: Pressure graph is a histogram that displays the average pressure levels 

delivered on any particular a day.  
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Long Term Data – Pressure 

 
Compliance 
This page provides the information about compliance. 
¾ Used Days 
y Number of Days: The total number of days the user used (Utilization) and did not use 

(No Utilization) the device. 
y Average of Days/Week: The average of days per week the user used (Utilization) and did 

not use (No Utilization) the device. 
y % Average/Period: The percentage of days with device usage and without device usage. 
¾ Util Time (Utilization Time) 
y Average Compliance: The average daily compliance time per day.  
y Min. Compliance: The least amount compliance time for any one day.  
y Max. Compliance: The most amount of compliance time for any one day. 
¾ Analysis 

This section provides the information about the days that reach a minimum number of 
compliance hours. The minimum compliance hour is defined in Long Term Æ Time Edit Æ 
Minimal Compliance 

y Selected Period >= x h/d: The number of days that reached a minimum number of 
compliance hours. 

y % of Utilization Days days with usage >= x h/d: The percentage of days that reached a 
minimum number of compliance hours.  

 
Long Term Data – Compliance 
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Events 
This page provides the information about total number or index (average events/hours) of 

detected events. 
y AHI: The total number or index of apnea plus hypopnea. 
y Apnea: The total number or index of apnea. 
y Hypopnea: The total number or index of Hypopnea. 
y Vibratory Snoring: The total number or index of snoring. 

 

 
Long Term Data – Events 


